A Principled Technologies report: Hands-on testing. Real-world results.

The science behind the report:

Experience longer battery life,
increased responsiveness, and cooler

surface temperatures with the HP
EliteBook 645 G9 Notebook PC

This document describes what we tested, how we tested, and what we found. To learn how these facts translate
into real-world benefits, read the report Experience longer battery life, increased responsiveness, and cooler
surface temperatures with the HP EliteBook 645 G9 Notebook PC.

We concluded our hands-on testing on September 20, 2022. During testing, we determined the appropriate
hardware and software configurations and applied updates as they became available. The results in this report
reflect configurations that we finalized on August 9, 2022 or earlier. Unavoidably, these configurations may not
represent the latest versions available when this report appears.

Our results

To learn more about how we have calculated the wins in this report, go to http://facts.pt/calculating-and-highlighting-wins.
Unless we state otherwise, we have followed the rules and principles we outline in that document.

Table 1: Results of our testing.

HP EliteBook 645 G9 with Dell™ Latitude™ 5430 with Dell Latitude 5420 with
AMD Ryzen™ 7 PRO 5875U Intel® Core® i7-1265U Intel Core i7-1185G7

MobileMark 2018

Battery size (WHTr) 42 41 63

Overall battery life (hours:min) 7:58 6:14 8:44

Overall performance 1,139 1,574 1,442

qualification

Normalized system efficiency 11.38 9.12 8.32

score (min/WHr)

Productivity subscore 1,141 1,470 1,314

Creativity subscore 1,147 1,608 1,592

Web browsing subscore 1,130 1,651 1,433

Cinebench R23

Multi-core score 9,480 9,375 5,032

Single-core score 1,433 1,764 1,473
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HP EliteBook 645 G9 with
AMD Ryzen™ 7 PRO 5875U

Dell™ Latitude™ 5430 with
Intel® Core® i7-1265U

Dell Latitude 5420 with
Intel Core i7-1185G7

Cinebench R23 thermal testing

Multi-core score 9,459 7,311 4,527
Keyboard deck average 45.2 54.0 45.2
temperature (degrees Celsius)

Underside of chassis average 46.4 60.1 391
temperature (degrees Celsius)

PCMark 10 benchmark test

Overall rating 5,708 5,672 5,363
Essentials rating 10,195 11,490 10,445
Productivity rating 9,246 7,415 7,093
Digital Content Creation rating 5,356 5,812 5,650
PassMark PerformanceTest 10

Overall rating 4,289 3,837 3,508
CPU Mark score 18,714 18,637 12,669
2D Graphics Mark score 628 370 347
3D Graphics Mark score 1,494 3,040 3,227
Memory Mark score 2,367 3,306 3,270
Disk Mark score 24,569 38,196 25,142
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System configuration information

Table 2: Detailed information on the systems we tested.

System configuration information

HP EliteBook 645 G9

Dell Latitude 5430

Dell Latitude 5420

Processor

Vendor

AMD

Intel

Intel

Model number

AMD Ryzen™ 7 PRO
5875U

Intel Core™ i7-1265U

Intel Core i7-1185G7

Core frequency (GHz) 2.0 1.8 3.00

Number of cores 8 10 4

Cache (MB) 16 (L3) 12 12

Memory

Amount (GB) 32 32 32

Type DDR4 SDRAM DDR4 SDRAM DDR4 Non-ECC
Speed (MHz) 3,200 3,200 3,200
Integrated graphics

Vendor AMD Intel Intel

Model number

AMD Radeon™ Graphics

Intel Iris® Xe Graphics

Intel Iris Xe Graphics

Storage

Amount (TB)

1

1

1

Type

PCle® NVMe® SSD

M.2, PCle NVMe, SSD

M.2, PCle NVMe, SSD

Connectivity/expansion

Wired internet

Realtek PCle Family
Controller

Intel Ethernet Connection
(16) 1219-LM

Intel Ethernet Connection
(13) 1219-LM

Wireless internet

Realtek RTL8852BE AX

Intel AX211 WiFi 6e 2x2

Intel Wi-Fi 6 AX201

Wi-Fié + BT5.2 AX+ BT 5.2 2x2 .11ax 160MHz +
Bluetooth 5.2

Bluetooth 5.2 5.2 5.2
USB 3x USB 3.2 2x USB 3.2 2x USB 3.2

1x SuperSpeed USB

Type-C
Thunderbolt N/A 2x Thunderbolt 4 2x Thunderbolt 4
Video Tx HDMI Tx HDMI 1x HDMI
Battery
Type Lithium-polymer Lithium-polymer Lithium-polymer
Size 3-Cell 4-Cell 4-Cell
Rated capacity (WHr) 42 41 63

Experience longer battery life, increased responsiveness, and cooler
surface temperatures with the HP EliteBook 645 G9 Notebook PC

November 2022 (Revised) | 3



System configuration information

HP EliteBook 645 G9

Dell Latitude 5430

Dell Latitude 5420

Display

Size 14 inch FHD 14 inch FHD 14 inch FHD

Type Anti-Glare WLED UWVA Non-Touch, Anti-Glare, Non-Touch, Anti-Glare,
250 nit Narrow Bezel - IPS, RGB Camera, 250 250 nits, WLAN/WWAN,
Non-Touch nits, WLAN HD+IR Camera

Resolution 1920x1080 1920x1080 1920x1080

Touchscreen No No No

Operating system

Vendor Microsoft Microsoft Microsoft

Name Windows 11 Pro (64-bit) Windows 11 Pro (64-bit) Windows 11 Pro (64-bit)

Build number or version 21H2 (10.0.22000) 21H2 (10.0.22000) 21H2 (10.0.22000)

BIOS

BIOS name and version U77 Ver. 01.06.01 Dell Inc. 1.4.0 Dell Inc. 1.19.0

Dimensions

Height (in.) 0.78 0.76 0.76

Width (in.) 12.67 12.65 12.65

Depth (in.) 8.42 8.35 8.35

Weight (Ib.) 3.09 3.01 3.03

HP provided the HP EliteBook 645 G9 Notebook PC we tested, so while we can't cite the exact price for it, as of October 25, 2022, similarly
configured AMD Ryzen 7 PRO 5875U processor-enabled EliteBook devices available from HP align with this price structure. The price of

the HP EliteBook 645 G9 Notebook PC in Table 3 includes the same processor, memory, storage, and screen as the model we tested—the
battery size and power adapter are the only differences between the version we tested and the version for pricing in Table 3.

Table 3: Pricing information for an HP EliteBook 645 G9, a Dell Latitude 5430, and a Dell Latitude 5420.

HP EliteBook 645 G9
(51 WHr battery)

Dell Latitude 5430
(41 WHr battery)

Dell Latitude 5420
(63 WHr battery)

Price according to vendor website (US dollars)

$1,916.60

$2,519.382

$1,433.82°

—_

. We collected pricing information on October 24%, 2022 from https://www.hp.com/us-en/shop/ConfigureView?langld=-1&storeld=10151&catalo

gld=10051&catEntryld=3074457345620273818&urlLangld=&quantity=1. For processor, we selected AMD Ryzen 7 PRO 5875U; for memory, we
selected 32GB DDR4; for storage, we selected 1TB PCle NVMe SSD; and for screen, we selected 14-inch diagonal LED IPS UWVA anti-glare FHD.

2. We collected pricing information on October 24, 2022 from https://www.dell.com/en-us/shop/dell-laptops/latitude-5430-laptop/spd/latitude-
5430-laptop/gctol5430usvp?redirectto=SOC&configurationid=86102636-26a2-40b57-9479-75532a8148d3.

3. We collected pricing information on October 24, 2022 from https://www.dell.com/en-us/shop/dell-laptops/latitude-5420-laptop/spd/latitude-
5420-laptop/cto11542014us?redirectto=SOC&configurationid=0db7737d-6bd2-4983-bé5a-ddec00fb2370.
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How we tested

Setting up the systems

Creating and updating the OEM Windows 11 Pro Image

Boot the system.
Follow the on-screen instructions to complete installation, using the default selections when appropriate.
In the bottom right-hand corner, click the battery, and adjust the Windows Power mode (plugged in) to Best Performance.

Unplug the system, and in the bottom right-hand corner, click the battery. Adjust the Windows Power mode (on battery) to Best
Performance, and plug the system back in.

5. Set DPI scaling to 100 percent, and set Screen and Sleep options to Never:

AN

a. Right-click the desktop, and select Display settings.

b. Under the Scale and layout section, for the Change the size of text, apps, and other items option, select 100 percent.
c. From the left column, select Power & Sleep.

d. For all power options listed under Screen and Sleep, select Never.

6. Disable User Account Control notifications:

a. Select Windows Start, type UAC, and press Enter.
b. Move the slider control to Never notify, and click OK.

7.  Disable Virtualization Based Security:
8.  Select Windows Start, type Group Policy, and press Enter.

a. Select Computer Configuration->Administrative Templates—>System->Device Guard.
b. Double-click Turn on Virtualization Based Security.
c. Select Disabled, click Apply, and click OK.

9. Run Windows Update, and install all available updates.
10. Launch the Windows Store app, and install all Store app updates.
11.  Launch each vendor proprietary utility app installed on each system, and update any drivers or BIOS files.

a. For Dell, run the Dell Command Update utility.
b. For HP, run the HP Support Assistant utility.

12. Verify the date and time are correct, and synchronize the system clock with the time server.

13.  On the system with an Intel processor, install Intel CPU Runtime for OpenCL Applications for Windows OS (64bit or 32bit) from https://
registrationcenter.intel.com/en/forms/?productid=3207 &pass=yes.

14. Disable Automatic Windows Update:

Right-click Start.

Select Computer Management.

Select Services and Applications.

Select Services.

Scroll down, and double-click Windows Update.

Click Stop.

From the Startup type drop-down menu, select Disabled.

@ m0o a0 T

Capturing an image

1. Connect an external HDD to the system.
2. Open Control Panel, and to select All Control Panel Items, click the arrow.
3. Click Backup and Restore.
4. Click Create a system image.
5. Verify that the external HDD is selected as the save drive, and click Next.
6. Verify that all drives are selected to back up, and click Next.
7. Click Start backup.
8. At Do you want to create a system repair disc, select No, and close the dialogs.
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Restoring an image

Connect an external HDD to the system.

Press and hold the Shift key while restarting the system.
Select Troubleshoot.

Select Advanced options.

Select See more recovery options.

Select System image recovery.

Select Next at the Restore system files and settings screen.
Verify that the external HDD is selected, and click Next.
Once the recovery has completed, click Finish.

Vo Nk wWwN =

Testing with MobileMark 2018

Avoiding antivirus software conflicts

MobileMark 2018 is not compatible with any virus-scanning software, so we uninstalled any such software present on the notebook PCs
before we installed the benchmark.

Avoiding pre-installed software conflicts

MobileMark 2018 installs the following applications, which its test scripts employ:

Productivity

* Adobe® Acrobat® Pro DC
e AutolT 3.3.14.2

* Google Chrome

* Microsoft Excel 2016

* Microsoft OneNote 2016

* Microsoft Outlook 2016

* Microsoft PowerPoint 2016
* Microsoft Word 2016

* Windows Zip

Creativity

* Adobe Photoshop® CC
e Adobe Lightroom® Classic CC
 CyberLink PowerDirector® 2015

Web Browsing

* Google Chrome
* Microsoft Movies & TV
If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts.

To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs
MobileMark 2018 uses—before we installed the benchmark.
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Adjusting display brightness and power settings

The brightness of a notebook’s display affects its battery life. Therefore, BAPCo requires that, before you test with MobileMark 2018, you
ensure the brightness of the notebook’s monitor is greater than or equal to 200 nits in the center of a completely white screen while the
notebook is unplugged and running on battery power. The measurement follows the standards from the Video Electronics Standards
Association (www.vesa.org).

We complied with this standard for all our tests by setting each notebook PC's brightness as close to 240 nits as we could without going
below that level. We used the following procedure before we started each test. Note: This procedure assumes we began with the notebook
plugged into the power supply.

To create a completely blank, white screen, open Microsoft Paint by clicking Start->All Programs->Accessories—> Paint.
To open the Resize and Skew dialog, press Ctrl+W.

Under Horizontal and Vertical, type 200, and click OK.

Click the View tab.

To view a white screen, click Full screen.

To allow the screen to warm, wait 45 minutes.

Click Brightness Profiler, and do the following:

Noank,rwbd~

Allow the white screen to warm up for 30 minutes. After 30 minutes, click Skip.

At the Panel Dark Luminance window, select Yes to use the value that is queried from the display.
Place the X-Rite - i1Display Plus colorimeter in the outlined spot on the screen.

On the colorimeter PC, start i1Profiler program, and select Advanced.

Click Display, and click Profiling.

Next to Luminance, click the drop-down menu, and select Measure.

In the drop-down menu that appears, select Paper in booth.
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In the box with the image that reads Place your paper in the light booth, scroll down, and click Measure.
On the test PC, adjust the slider until the colorimeter PC meets the Target White luminance.
j. Once the correct Target White luminance is met on the test PC, click Done.

8. If the reading is below or significantly greater than 240 nits, adjust the screen brightness to as close to 240 nits as you can without going
under, and retest:

a. Click Start.
b. Inthe Windows Start search box, type display settings.
c. Adjust the slider to change the Display brightness to the correct percentage that produces no less than 200 nits.

9. Allow the notebook to run on battery power for 10 minutes, re-measure the display, and adjust the brightness up or down as necessary.
10. Verify that the notebook saved the brightness setting by plugging in the system, unplugging it, and taking another reading.

Using the MobileMark built-in configuration tool
This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

The configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required

e Disables User Account Control (UAC)
* Set DPI Scaling to 100%

e Disables Low Battery Actions

e Disables Network Proxies

* Disables System Sleep and Hibernate
* Disables Windows Update

* Enables Windows Search
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Level 2 - Recommended

* Create BAPCo power scheme

* Set Power Plan Type to Balanced

* Set CPU Adaptive Mode

e Disables Battery Saver Dimming

* Verifies Battery Saver Threshold

e Disables Disk Defrag

e Disables Windows Error Reporting

e Disables Windows Lock Screen

* Disables Windows Pop-ups

e Disables Screen Saver and Monitor Timeout
e Disables Windows Sidebar/Gadgets
* Disables Desktop Slideshow

* Disables Windows Defender

e Disables Windows Firewall

e Set Font Smoothing

Level 3 - Optional

e Disables Hard Disk Timeout
* Disables System Restore

* Ignores Laptop Lid Close

We chose the official BAPCo “Run Benchmark” default as outlined in the BAPCo MobileMark2018 User Guide (http://bapco.com/
wp-content/uploads/2019/03/BAPCo_MobileMark2018_user_guide_v1.3.pdf), which runs the benchmark using the Required and
Recommended options.

Setting up the performance-qualified battery life test

1. On a separate PC, install the i1Profiler software from https://www.xrite.com/categories/formulation-and-quality-assurance-software/
iTprofiler, and connect the X-Rite - i1Display Plus colorimeter to that PC.

2. On the test PC, verify that the wireless adapter is enabled and connected to a wireless router that is not connected to the internet.

3. On the test PC, verify that the Lower screen brightness when using battery saver is turned off.

a. Select Windows Start, type Battery saver, and press Enter.
b. Next to Turns on at 20%, click the down arrow. Next to Lower screen brightness when using battery saver, toggle
the button to Off.
4. On the test PC, verify that the volume is set to 50 percent.
On the test PC, install MobileMark 2018 with the default options.
6. On the test PC, disable Windows Defender Antivirus.

o

Select Windows Start, type Group Policy, and press the Enter key.

Select Computer Configuration>Administrative Templates>Windows Components->Microsoft Defender Antivirus.
Double-click Turn off Microsoft Defender Antivirus.

Select Enabled, and click Apply and OK.

Reboot the system for the changes to take effect.

° a0 oo

Experience longer battery life, increased responsiveness, and cooler

surface temperatures with the HP EliteBook 645 G9 Notebook PC November 2022 (Revised) | 8


http://bapco.com/wp-content/uploads/2019/03/BAPCo_MobileMark2018_user_guide_v1.3.pdf
http://bapco.com/wp-content/uploads/2019/03/BAPCo_MobileMark2018_user_guide_v1.3.pdf
https://www.xrite.com/categories/formulation-and-quality-assurance-software/i1profiler
https://www.xrite.com/categories/formulation-and-quality-assurance-software/i1profiler

Running the performance-qualified battery life test

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

AN

5. After the command completes, wait five minutes before running the test.

6. We set all three systems to ~240 nits using the process outlined in the prior section Adjusting display brightness and power settings.
7. Launch MobileMark 2018.

8.  Click the Settings Gear.

9. Verify that Conditioning Run is enabled.

10. Enter a name for the benchmark run.

11. To return to the main menu, click Back.

12. Click Run Benchmark.

13. When prompted, unplug the AC power adapter. The test will begin immediately.

The benchmark is complete when the notebook PC has fully depleted its battery and is no longer operational when running
on battery power.

We executed the MobileMark 2018 benchmark three times on the system and took the median performance score run as the representative
battery life result for that test.

Testing thermals with Cinebench R23

Setting up the test

1. Download and install Cinebench from https://www.maxon.net/en/downloads/cinebench-r23-downloads.

A FLIR E6xt Infrared Camera is necessary for taking top and bottom skin temperatures.

Running the test

Launch Cinebench.

Select File>Advanced benchmark.

Set the Minimum Test Duration to Off.
Select CPU (Multi Core), and click Start.
Record the results for the next 30 iterations.
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At the end of each result, take a skin temperature photo of the top and bottom, and report the hottest spots.

Testing with the PCMark 10 benchmark test

Setting up the test

Purchase and download the PCMark 10 benchmark from https://benchmarks.ul.com/pcmark10.
Install PCMark 10.

Launch PCMark 10.

Select Business Edition, and input the license key.

Close PCMark 10.

areDN -

Running the test

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

PwON =

After the command completes, wait five minutes before running the test.
Launch PCMark 10.

To begin the test, while on the Home tab, click Run.

When the test completes, record the results, and shut down the system.
Complete steps 1 through 8 twice more, and record the median results.
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Testing with Cinebench R23

Setting up the test

1.  Download and install Cinebench from the Microsoft Store.

Running the test

Launch Cinebench.

Select either CPU (Multi Core) or CPU (Single Core), and click Start.
Record the result.

Wait 15 minutes before re-running.

areODN -

Complete steps 1 through 4 two more times.

Testing with PassMark PerformanceTest 10

Setting up the test

Install PassMark PerformanceTest 10.

Download PassMark PerformanceTest 10 from https://www.passmark.com/products/performancetest/download.php.
To begin the installation, press Install.

Select Accept to accept the license agreement, and press Next.

AR

After the installation is complete, deselect Launch Performance Test, and press Finish.

Running the test

To launch PassMark Performance Test, press the PassMark Performance Test icon.
To start the benchmark, click Run Benchmark.

When the test completes, record the results.

Complete steps 1 through 3 two more times.

Report the median of three runs.
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Read the report at https://facts.pt/UaJ2Ji4F >

This project was commissioned by HP & AMD.

‘ Principled

Technologies®

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:

Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or resullt.

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of
the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with
Principled Technologies, Inc.’s testing. Customer's sole and exclusive remedies are as set forth herein.
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